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Introduction

1.1 Purpose and Functions

The EIA-176 Query System is a PC-based system for users to produce reports and
extract data from the EIA-176 database that is used to produce the Natural Gas Annual.
Its purpose is to provide users with company-level data. This information is available in a
format similar to the survey form for individual companies, as well as in files suitable for
tabular calculation.

The query system has two functions. e The first is to provide individual company
responses in a form that resembles the EIA-176 survey form. This is viewable on-line,
and available in a printed form. Appendix A shows a sample EIA-176 form. Each
respondent is available in the year they reported data on the form EIA-176.

e The second function is to provide files of EIA-176 data for use with other software
packages. The query system provides two methods to obtain tabular data. (1) a set of 24
pre-selected queries. The information in these queries was designed to satisfy the bulk
of data requests received by the EIA. Appendix B outlines the pre-selected queries and
their data items. And;

(2) The second method is for user-selected queries. These queries offer users the ability
to access sets of data items not included in the pre-specified queries. Appendix C
outlines the available data items. Data in the pre-selected and user-selected queries
includes adjustment entries made by EIA staff to ensure that EIA-176 and publication
data balance.

Data sets from both query methods can be saved to separate files in a variety of popular
formats that include: text, comma-delimited for spreadsheets, SDF files for use with
dBase, and fixed width format for use in other software packages.

New in the pre-selected query section is a report of Name/Address data, a report

detailing individual company items shown in the continuation pages of the form, and LNG
activity.
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1.2 Hardware and Software Requirements

The minimum hardware requirements needed to install and use the EIA-176 Query
System are:

eAn IBM-compatible personal computer (PC) — minimum Pentium 75 is suggested and 24
MB of RAM

eThe Windows operating system 95, 98, 2000, XP or NT —4.0 Service Pack 3 or later*
eInternet Explorer 5.0 or higher

eAn 80-column monitor

¢15 MB of hard-drive space

* - See the ‘Getting Started’ document for notes about installing and using the EIA-
176 Query system with Access 2003.

2.0 Installing the Query System
2.1 Installing the EIA-176 Query System

To install the EIA-176 Query System on your PC:

1) Download the software from the EIA web site.

2) Open Windows Explorer and find the file. The name will depend on which version was
selected. All executables will begin with EIA176Qry. The rest of the name will indicate
the version of Access that was selected.

3) Double click on the file EIA176Qry....exe and follow the instructions.

4) As the installation begins, a ‘Welcome’ screen is displayed. Click the ‘Next’ button to
continue.

5) The ‘Select Destination Directory’ screen will be displayed. Click the ‘Next’ button if you
wish to continue the installation to the default directory — C:\Program Files\EIA176Qry. If
you wish to change the default directory, click the ‘Browse’ button.

6) The ‘Ready to Install’ screen will be displayed. To continue with the installation click on
the ‘Next’ button.

7) A progress bar will appear.

8) When the installation is completed the ‘Installation Completed’ screen will be displayed.

Note: In some instances you will be prompted to re-start you computer to complete the

installation. This is normal and can be done immediately to use the query system, or later if

so desired.

2.2 Starting the EIA-176 Query System

The query installation program creates a program group and a desktop icon for the EIA-176
Query System. The desktop icon starts the query system up immediately and appears on the
desktop after the install program runs.

2.3 Compressing the File for best performance

The program group, which is available through the START menu has the EIA-176 Query System
icon, as well as an option to Optimize (Compact and Repair) the query system.
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Mew Office Document

Eq Open Office Document
.
SideStep

=

EE Frograms

Comman Collection and Processing Spstem [CCAPS] P | 2 Microsoft Mettdesting
Corel VENTURA 8 P | Eo Microsoft Outlook
Carel5 Microsoft PowerPoint
ElA &pp : El4-176 Query System
El& LaMN Applications ﬁ Optimize D atabaze
EI4-176 Query Spstem » Tl M5D0S Prampt
ExTRA! for Windows L4 I“_:;] Outlook Express
Gator 4 @ SideStep

|lomega 4 @ Wwindows Explorer
Microsoft Hardware r

Microsoft Office Pro 95 L

Microzoft Reference L

Microgoft SEL Server 7.0 k

The Optimize option should be run periodically so that the query database does not become
fragmented. In the Access 2000 version the compact and repair option is available from the File

Menu.

F] EIA-176 Query System
I File Edit Datasheet Exit
= Cloze Window/Fepart
Save bz
Export...

Compact and Repair Databaze..

% Erirtt...

L

ia)
|

In the Access 97 version it is only available from the Program Group, as shown above.
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3.0 Using the Query System

After a successful installation you can use the query system to print off individual company
submissions or to generate data files from your Windows desktop by clicking the START button,
then the Programs button. Select the EIA Applications items, and then click EIA-176 Query, and
the Main Menu Screen of the query system is displayed, as show below:

3.1 Main Menu
‘elq Energy Information Administration

~e most current ElA-176 Query System

:ars data are:

I2004

1997
1998
1999

000 | Query EIA-176 Data
2001
2002

atafor [2003

‘e also available | Exit

t the EIA Natural Gas web site at:
ooy eia.doe.goviol gashatural gasinfo glancehstural gas btml

View EIA-176 Respondents

rthe Natural Gas Navigator at:

riftonto eia.doe govidnawingng sum top.asp

The three main options available in the EIA-176 Query system are accessed via this
menu. They are:

1) View EIA-176 Respondents: Click this to choose individual respondents and view
or print their submissions

2) Query EIA-176 Data: Click this to choose pre-selected or user selected queries
which will allow the user to save data to PC-compatible files
3) Exit: This ends the EIA-176 query.

Each option is described in the sections that follow.
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3.2 View EIA-176 Respondent
3.2.1 Select a Company

After clicking the View EIA-176 Respondents button on the Main Menu, the following Choose
EIA-176 Company Screen is displayed.

1) Select the report year first.
2) Select the retrieval method

& Viow EIA 176 Rospondonts Chooso Compamyts) R
View EIA-176 Respondents - Choose EIA-176 Company(s)
: 1997
You can Please enter a report year: THGE
select one Choose a retrieval method 1933
or more 2000
companies D e " 200
by name or elect a Company in a State 2002
state 2003
: % Select a Company by Name 2004
Use the
arrow
buttons to View =>
select a
state or
company. Erint
Selections
<=Back

If you select a company by name you will see a list of EIA-176 company names. If you select a
company in a state you will get a list of states. The companies will appear after you select a state.

3.2.1.1 Select a Company in a State

If you Select a Company in a State you'll see a list of states

Highlight the state(s) you want and use the single right pointing arrow located in-

between the two white boxes to move the state to the selected box.

To unselect a state use highlight it in the selected (leftmost) box and use the single left

I 1
pointing arrow J to move the state out of the selected box.

Once you've selected a state click on the Select Company button to see available companies
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Select
Company

within that state.

Use the mouse to select the company you want to view in the Companies available box. Click the

right pointing arrow to move it to the selected box on the right.

3.2.1.2 Select a Company by Name
£ View EIA176 Respondents Choose Compamyts) R
View EIA-176 Respondents - Choose EIA-176 Company(s)

You can Please enter a report year:
select one Choose a retrieval method
or more
companies . .
by name or % selecta Company in a State
L C  Select a Company by Name
Select Respondent Name
Companies Available Companies Selected
A7 |ADJUSTMENT P LCC EL PASO NATURAL GAS CUAZ
A7 BENSON CITY OF Select
Use the A7 EL PASO NATURAL GAS COMI ey
arrow AZ  GRAHAM COUNTY UTILITIES I
e A7 MESACITY OF 5| :
L A7 MOJAVE PIPELINE COMPANY View =>
select a A7 NAVAJO TRIBAL UTIL AUTH <
state or A7 SOUTHERN TRAILS PIPELINE .
company. A7 SOUTHWEST GAS COR |= Brint
AZ | STAFFORD UTILITIES CITY OF Selections
A7 TRANSWESTERN PIPELINE C -
AZ NS GAS INC
A7 WILLCOX CITY OF <=Back
i 2l
El Paso Natural Gas has been selected.
3.3.2 View and Print EIA-176 Respondent Submission
View =>
To view the submissions click the View=> button.
Print
Selections

To print the submission without previewing it click the Print Selection button.
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iew ElA-176 Company

o yrweea, doe.goy
em |Energy Information
Administration

FORM EIA-176
REPORT YEAR 2002

Farm 2pproved
OB Mo, 19030175
Expiration Drate: 117300

ANNUAL REPORT OF NATURAL AND SUPPLEMENTAL GAS SUPPLY AND DISPOSITION

confidentialitya finfmmation and mandtions statements, sz instructions.

its purisdiction

Thiz report is mandatory underthe Federal Energy Administration Act of 197 4 (Public Law 93-274), Forthe prowisions conc: ming the

Tide 18 USC makes it a criminal offense for any person knowingly and willingly to make to any Agency
or Department ofthe United States any false, fictitious, or fraudulent statements as to any matter within

SECTIOH 1. RESPOHDENT IDEHTIFICATION

Ertar e nams and malling addre e o 41e company fllng 11s EL-178
EIA ID Humber 176035564

Company Name: EL PASC NAT G5 CO
Opergtions in (S@te): Opzin ARIZON A

Address 1:

Address?:

City

View Respondent result — Preview screen

Cormnplete and retum by March 1, 2003 to
Erergy Information Admini stration:

L5, Department of Erengy
P.0 Box 8279
Silwer Prird, MD 20907
ABTTH: Formn E1A-1TE

OR
Faxto: [202] 326-1076

Ernail to: 000G SURMEY Sieiz.doe gow

You can maximize the preview screen by clicking on the resize button in the upper right corner.

| e

You can view subsequent pages of the preview screen by clicking the navigation buttons at the

bottom of the screen.

Page, Wil 1 SR LI i

The right pointing arrow > takes you to later pages.

The right arrow with the bar >| takes you to the last page.
The left pointing arrow < takes you to earlier pages.

The left arrow with the bar |< takes you to the first page.

EIA-176 Query System 12/2/05 -

90f 39



EIA-176 Query System User’s Guide 12/2/05)

3.2.2.1 View EIA-176 Company Menu

The View EIA-176 Company Menu lets you control this display.
E; EIA-176 Query System

“ Exit 0 Page Setup... SO0 ESherint... B Cose

‘ Eat — Closes this application.
M FeseSeue ""_— Allow you to choose a printer and set the page orientation (portrait works best).
e — Changes the magnification of the report.
. I Sends the report to the printer.
i Close

_ — Closes this report and either shows the next report if you've selected more than
one, or returns you to the Choose Company screen.

Once you've returned to the Choose Company Menu you can exit this function by clicking on the
<=Return button.

<=Return |

This will return you to the Main Menu.
3.2.2.2 Choose Company Arrow Functions

Below is a summary of what the arrow buttons in the Choose an EIA-176 Company
do:

Moves the highlighted item in the left box to the right box.

Move all the items in the left box to the right box.

H
e Moves the highlighted item in the right box to the left box.
1 Move all the items (highlighted or not) from the right box to
— the left box.
M
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3.3 Query EIA-176 Data
To view, select the Query Menu from the Main Menu.
There are two query options: Pre-selected, and User-selected.

B3 Query EIA-176 Data - Query Menu

Query EIA-176 Data

Preselected Query Menu
queries
create files
with
redetermined )
pEIA-1 76 items Pre-selected Queries

— (see notes for available years)

Custom
queries create
files with EIA- _l Custom Queries
176 items that

are selected
from a list

Back

L

The Pre-selected Queries option offers 24 queries that can be run on all or selected companies.
The queries and the data items they include are detailed in Appendix B.

The User-selected Queries option allows users to select other EIA-176 data items for inclusion
in data fields. They have a structured format. The rows will always be EIA-176 companies; users may
select column data values.

The following sections will describe these two options.

3.3.1 Pre-Selected Queries

Pre-selected queries are queries whose conditions have already been created. These queries save
the user the trouble of having to set the desired conditions each time he/she wishes to run the pre-set query.

The following pre-set queries are available:
Sorted by:
State
Volumes by sector (sales + transported)
Prices by sector
Rankings, by volume, national, and within States
Type of Operations

Other:
Detailed data on continuation lines.

The first step in the pre-selected queries is to choose the year and company(s) you want to query.

EIA-176 Query System 12/2/05 - 11 of 39
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3.3.1.1 Select a Company Screen

The Select Company screen for the queries is quite similar to that described in the View Respondent option
which is described in section 3.3.1.

Begin by selecting a year in the ‘Please enter a report year:” .

You can select EIA-176 companies to include in your queries. If you want all companies choose the Select All

Companies option, this retrieval method does not appear on the View Respondents menu. This will close this
screen and go to the select queries screen.

The same white boxes that were used in the view respondent data are used here. If you Select a Company in a
State you'll see a list of states to choose from.

Once you've made your selections click the Next=> button to select a query to run.

Next => |

B ElA-176 Pre-selected Queries i [=] S

Select a Query to Run 2004
You have Selected Years:
selected all
companies
Pre-selected Queries Query Description
All Part v &V tems (Volumes) ﬂ Al consumption items by part and line
All Part ¥l ltems (Volumes, Cost number. In an easy to pivot farmat far
& . CONSUMEers ) Excel.

AG 3‘ Al Sector ltem
Ak

All Sector items sorted by state

AL Sector Sector Prices

o List of Reparted Affiliates

Az List of Reported Comments

BR Residential Sectar Volumes - Delivered, Transported, Tatal
CA Company Mame Infarmatian

Ch Commercial Sector Volumes

co Detail level Continuation Lines

oT =

Industrial Sectaor Yolumes
Footnotes and Associated Data Values

b Aele coabod] e coedar _‘I

<=Back | Run Query =>

A detailed description of each pre-selected query can be obtained by highlighting the query title. The description
appears in the box titled Query Description.

Once you've selected a query by highlighting it, click the Run Query=> button to execute the query.

Run Query =>

EIA-176 Query System 12/2/05 - 12 of 39
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The status bar is displayed at the bottom of the screen while the query is running. Some queries take a few
moments to be displayed.

pAfining query [mm progress.

The blue bars
show query

I # EIA-176 Pre-selected Queries x| -

= Qry_AllCon_1 : Select Query

1760014140 MIDCOAST INTERSTATE TRANS IMAL 0 0.0

Record: 14 (] TS T L T~ |

LT T T L= = oy e oy — |

<=Return Run Query =>

Query output is displayed in a grid on your screen.

3.3.1.3 EIA-176 Query Menu Functions

Menu items at the top of the screen are used to filter output, or export to other data formats.

%, Microsoft Access

| Bie Edit Datashest Tooks Ext

File
" File Edit Datasheet Tools Exi

i r'|.-.-.= WindownReport | Close — Closes the query grid.
el - Save As/Export —Saves the data to another file
Save fs/Export Datafile Page Setup — lets you choose print settings
L0 page Setup... Print Preview — Shows what a printout will look like
(&, Print Prexiew Exit — Quits the Query system.
Close Spreadshest
&h prirt...
Exit
EIA-176 Query System 12/2/05 -

|| CompanylD COMPANYNAME ST ResVol ResCost |ResConsumer] CommVol

L 176 y  BARROW UTIL & ELEC COOP INC AK 221,971 514,510.0 1,132 387,87

| |17602009AK  UKPEAGVIK ARCTIC SLOPE AR 0 0.0 0 1,465 7€

| |17602016AK  ALASKAP L CO AR 0 0.0 0

| |17602017AK | ENSTAR NAT GAS CO AR 15,756,589 | 565859870 90,117 £,698 40

| |176133004K  \MARATHON OIL CO AR 0 0.0 0

| |17617544AK  CHEVRON USA PROD INC AR 0 0.0 0

| |17617545AK  UNION OIL CO OF CALIFORNIA — AK 0 0.0 0

| |17619863AK  PHILLIPS ALASKA NAT GAS CO  AK 0 0.0 0

| |17622751AK  ARCO ALASKA INC AR 0 0.0 0 7,099,2¢

| |17600048AL  FLORALA GAS DEPT AL 21,680 1331700 542 2

| |17600049AL  WEST JEFFERSON GAS SYS AL 25,653 24590930 520 30

| |17600139AL  ALABAMA GAS CORP AL 27 627365 258,719,083 0 430,069 9,747 2(
0
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Close — Exits the select query window.

Save As/Export - option opens an intermediate box.

-

———

CompanylD COMPANYNAME ST ResVol ResCost ResConsumer]y Com

¥ 176020035 BARROW UTIL & ELEC COOP INC AK 221,971 514,510.0 1,132 :

| |176020094K | UKPEAGVIK ARCTIC SLOPE AK 0 0.0 0 1.4

| |17602016AK  ALASKAP L CO 0.0 0
17602017AK  ENSTAR NAT GAS C 5,987.0 a0,117 6,6

T 175133008K  MARATHON OIL Cgf f_a‘_’e ey Al 0.0 0
17617544AK  CHEVRON USA PR O fite = SEEl Fils @ ilees 0.0 0

[ |176175454K  UNION OIL CO OF C i : Lce" 0.0 0
176198634K  PHILLIPS ALASKA M 0.0 0

[]178227514K  [ARCO ALASKA INC e iarre? [ony_alleon L 0.0 0 70

| |176000485L  FLORALA GAS DEP 3.170.0 542

| |176000494L  WEST JEFFERSON 5,093 .0 520

| [17600139AL  ALABAME GAS CORF AL 767,500 £55,719,088.0 430,069 a3

| |17600141AL  MIDCOAST INTERSTATE TRANS IN AL 0 0.0 0

Recard ae [ (I 7 imlaof 7z T AL T T e T

After you choose this option you will be presented with an initial ‘Save As’ dialog box. Select the
‘To an External File or Database’ option, and click the OK button. You will not be able to access
your file if you choose the ‘Within the Current Database’ option.

Next you will be presented with a Windows dialog box. Headers may look better when you select
Save Formatted.
You can put your own name into the File Name box.

=% Brp_AllCon_1 : Select Query

File name:

IQrv_AIICDn_l xls

Save as bype:

Mot all file bypes are installed by default, To add other file types, mdn the Setup program, click add/Remaove, Dat
he Office 97 WaluPack.

Access, Change Option. Additional file bvpes are also available i

CompanylD COMPANYNAME ST ResVol ResCost ResConsumers
L 176020034k, | BARROWY UTIL & ELEC COOP NG | Ak 221 871 514 5100 1,132
I ARV NI S ave Query "Qry_AlICon_1" In... HE
17602016AK. | ALL -
| |17eozoizaK  Ene R |1 ExportedFiles E| El ] El
- 176133004k fld IsaNeu\\lGas.ﬂtct.><Is ﬁNewGasActl.xls ﬁer_ConPrice_G.xls EUQWPS Expark I
| |17B17544AK | CHE PR newGasActE. s B NewGashct]. xls % |Qry_ConRank_3.xls
| |[17817545AK [ UNI ﬁNewGas.ﬁ.ctC.xls ﬁNewGasActK.xls ﬁQrv_ConRankST_S.xls L':EII
17E 19863 A1 PHI NewGassckD, xls ﬁNewGasActL.xls Qry_ConartSec_2.xls
B 17E22751 48k | AR NewGasAckE . xls ﬁNewGasActM.xls Qry_Conkinuations. xls
B 1760004841 FLC NewGashctF . xls ﬁNewGasActN.xls Qry_nma_%.xls atted -
| 1760004941 WE ﬂNewGas.ﬁ.ctG.xls ﬁNewGasActO.xls ﬁer_Prnd_CstS.xls Text files may
176001304, | AL ﬂNewGasF\ctH.xls Slory_ConcT_4ads B UCryPALRALL s Autostart | S&VE More
L | P | _'l succe_ssfully by
| [17B00147AL rIC avE checking the
| [17B00162AL  |ALE 4l Save
| [1760061BAL  ATH I Selection ﬁormatted box.
F————— — ou save
Record: 14|« || Excel files with

this option the
headers look

nice when you
open the file in

/

Different file type options are available by pulling down the ‘Save as File Type’ list box as shown.
By scrolling down the list of available file types you can choose dBase formats also.
Once you've named your file and selected the file type to save as click the Export button to finish

the operation.

EIA-176 Query System
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Page Setup
This option lets you set print settings and page orientation.

8 EIA-176 Pre-selected Queries

| sCost ResConsumers

1,132
a0
a0

a0, 117

o o OO

542
520
430,068

CompanylD COMPANYN | Wargins 1 Page

¥ 176020034 BARROW UTIL & ELE 14,510.0
[ |17602009AK  UKPEAGVIK ARCTIC| | [ Margins (inches) ~Sample 0.0
[ |17602016AK | ALASKAP L CO Iop: [ 0.0

176020178K  ENSTAR NAT GAS C( 85,957.0
[ |17613300AK  MARATHON OIL CO Bottom: [1" 0.0

176175444K | CHEVRON US4 PROL 0.0
_|176175458K  UNION OIL CO OF 4| Mo E 0.0

176198638K  PHILLIPS ALASKA N, 0.0
— Right: 1"
L [176227512K | ARCO ALASKA INC o | 00
[ |17600048AL  FLORALA GAS DEPT 33,170.0
[ |17600049AL  WEST JEFFERSON (|| [ Print Headings 15,9930
[ |17600139AL  ALABAMA GAS CORF 19,088.0
[ |17600141AL  MIDCOAST INTERST, 0.0
Record aaf 0] 1 v lmle]of 1762~ "'”

<=Return [
[8]4 I Cancel |

Most query output looks best with the print orientation Landscape. This can be selected from the

Page tab.

EIA-176 Query System

12/2/05 -
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Print Preview

i Qry_AllCon_1 : Select Query

Page: |4|<| 1 p|>||
The Print Preview buttons lets you see what the printout will look like.
Print

The Print button prints the grid off. Some of the queries may be large.

I 5 ElA-176 Pre-selected Queries
I

" Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol Res!
' [176020034K  BARROWY UTIL & ELEC COOP INC AK 221,971 5
| |176020098K  UKPEAGVIK ARCTIC SLOPE AK 0
| |176020168AK  ALASKAP L CO LK 0
| |176020178K  ENSTAR NAT GAS CO 56,5¢
| |176133008K  MARATHON OIL CO Naw printing page 3 of
| |176175448K  CHEWVRON USA PROD INC ‘Ory_AllCon_1" to the
| |176175458K  UNION QIL CO OF CALIFOI
| |176198638K  PHILLIPS ALASKA NAT GA ErEE I Sls PlTe D @ LT
| |176227518K  ARCO ALASKA INC
| |176000484L  FLORALA GAS DEPT 1:
| |176000488L  WEST JEFFERSON GAS SYS AL 25,653 2
| |17600138AL  ALABAMA GAS CORP AL 27,627,365 2587
17600141AL  |MIDCOAST INTERSTATE TRANS I AL 0
Recé?d“ﬁlﬂr“_“'r»h-hﬂ of 1792 “"'H<I - I .
=T = = s s L= e = T LTS = . P T Ty —— | T
EIA-176 Query System 12/2/05 - 16 of 39



EIA-176 Query System User’s Guide 12/2/05)

To use the Copy option the grid or column needs to be highlighted. The entire grid can be
highlighted by clicking in the upper left corner (circled). Individual columns can be highlighted by
clicking in the column header.

To use Find, select just one column by clicking on the column header. The ST column is
highlighted in this example.

JFiIe Edit Datasheet Tools Exit

Jg ‘Cupv Ctrl+C / E‘§|n

e® 8zl vwm a2 Ba- B

w_1: Select Query

[ CompanylD COMPANYNAME ResVol Res
Click in the p|> [ 176020034K  |BARROW UTIL & ELEC COOP INC 221,971 5
ﬁ'i;']ﬁégt e |IL_|17602008AK |UKPEAGYIK ARCTIC SLOPE 0
entire grid. (| |17602016AK ALASKAP L CO 0

[ |17602017AK  ENSTAR NAT GAS CO 15,756,589 56,5

[ [176133004K  MARATHON OIL CO 0

([ ]176175444K | CHEVRON USA PROD INC 0

{ 176175454K  UNION OIL CO OF CALIFORNIA 0

(|| 17618863AK  PHILLIPS ALASKA NAT GAS CO 0

(|_117622751A4K  ARCO ALASKA INC 0

[«| |176000485L  FLORALA GAS DEPT 21,680 1

With the column selected puII down the Edit menu and click on the Find option.

=F Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME sT ResVol ResCost F
|| 176183001N OHIO WALLEY GAS INC I 440,343 28500520
| 176190041 REMSSELAER GAS UTIL DERPT I 246,028 1,381,073.0
|| 176190191N POSEYVILLE MUN GAS CO I 29,650 2523860
| [ 176190241N WESTFIELD GAS CORP I 103,848 867.427.0
|| 176196331N TEXAS EASTERN TRANS CORP - (IN 1] 0.0
|| 17619807IN SWITZERLAMD CTY NAT GAS CO N 49,851 378,354.0
| | 17619892IN BAINBRIDGE MUN GAS I 25,260 2035850
|| 17619912IN NAPOLEON TOWYIN OF I 13,684 96,340.0
| | 17619913IN COMMUNITY MNAT GAS CO INC I 481,939 25710580
|| 17680608IN NAT GAS P L CO OF AMERICA I 1] 0.0
| | 17694105IM SIGCORE ENERGY SERVICES I 0 0.0
|| 17684713IN YVECTOR PIPELINE I 1] 0.0
P 17600032KS  ABBYVILLE CITY OF ﬁ 4,515 25,3850
[ R e | S T
Cunsumptlnn S/ol B
PP = LT IKS
<=Ret Search: IAII VI I match Qa.se Eind Mext |
" Search Fields &s Formatted
Match: #hole Field ¥ Search Only Current Field Close |

A dialog box will appear. Enter the value you wish to search for. After you've centered the value
you want to find click either Find First, or Find Next. The grid will advance to the found value or tell
you that no values exist.
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Datasheet

Datasheet Tools Exit

iA Fart...

i [0 Freegze Columns

" 2] cort Ascending
Z | sort Descending
W2 pdvanced Fiter/Sort...
W_ Apply Filker/Sort

¥, Rermove Filter/Sort

I ERGEEREEIS

[T

Font - adjusts the type in the grid

Freeze columns -makes the frozen column

always appear

Sort Ascending/Descending - sorts the data in

the grid by the selected column

Advanced Filter - lets you enter some simple
criteria for data in the query.
Apply Filter - is used in conjunction with

Advanced Filter

Remove Filter/Sort — removed the Applied

Filter

Datasheet items allow you to manipulate the query that you've run.

The Font menu item changes the font of the data in the grid.

COMPA

DWALLEY G, B

ISSELAER G.
SEYVILLE ML
STRIELD GA:
AS EASTERD
ITZERLAND ¢
NBRIDGE ML
'OLEON TOW
AMUNITY MNA]
GAS P L CC
ZORE EMER
-TOR PIPELN
MVILLE CITh

:_| " IHEHI DF 1h?”
nption Vals for

[N S U J P

<=Return

Font

Font style:

B arial Black =
B arial Marrow

B BakerSigret

B pellGothic

B pellGothic Black
B Bernhard Modern Rormilx |

—Effects

[ Underline

Color:

I-E.Iack j

|Regu|ar

Reqular
= 11 Cancel
Bald 1=z J
Bold Italic 14

1a

13

=l =
—Sample
AaBbYyiz

Script:
IWestern j

This is a TrueType font. This same font will be used on both

your printer and your screen.

2.0
73.0
£6.0
7.0
0.0
4.0
85.0
0.0
9.0
0.0
0.0
0.0
85.0

In this example, selecting Bold turns all the items bold.

EIA-176 Query System
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l &f Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol

| |17618300IN OHIO VALLEY GAS INC IN 440,343
| |17618004IN RENSSELAER GAS UTIL DEPT IN 246,026
| |17618018IN POSEYVYILLE MUN GAS CO IN 29,650
| |17618024IN WESTFIELD GAS CORP IN 103,846
| |17618633IN TEXAS EASTERN TRANS CORP IN 0
| |17618807IN SWITZERLAND CTY NAT GAS COIN 49,851
| |17619892IN BAINBRIDGE MUN GAS IN 25,260
L 17619912IN NAPOLEON TOWN OF IN| 13,684
| |17618913IN COMMUNITY NAT GAS COINC  IN 481,939
| |17680608IN NAT GAS P L CO OF AMERICA IN 0
| |17694105IN SIGCORE ENERGY SERVICES IN 0
| |17694713IN VECTOR PIPELINE IN 0
| |17600032KS  ABBYVILLE CITY OF KS 4515

Record: 14 4] 513 e e of 1792 T Al 1 S

The Freeze column options lets you always display one column on the screen.

To freeze columns place your cursor in the column you wish to always view. In this example that column is
COMPANYNAME.

COMPANYNAME ST CompanylD ResVol ResCost R
’_BA ROV LTIL & ELEC COJP INC|[AK 17B020034K 221,971 5145100
|| UKPRGYIK ARCTIC 5L0 A 17B020094K 0 0.0
|| ALASKA A 17E02016AK 0 0.0
| |ENSTAR NAT GAS CO A 17B02017AK 15,756,588 o56,585,987.0
| |MARATHON OIL CO Al 17613300AK 0 0.0
| |CHEVRON USA PROD INC Al 1761754441 0 0.0
| |UNION QIL CO OF CALIFORNIA | AK 1761754 54K 0 0.0
| |PHILLIPS ALASKA NAT GAS CO |AK 17619863AK 0 0.0
| |ARCO ALASKA INC Al 17B22751AK 0 0.0
| |FLORALA GAS DEPT AL 1760004841 21,680 133 170.0
| |WMVEST JEFFERSON GAS SY5 AL 1760004941 25,653 245,993 0
| |ALABAMA GAS CORP AL 1760013841 27827 265 258,719,0880
| |MIDCOAST INTERETATE TRANS INAL 17600141AL 0 0.0
Record w| (] 1 »impifaf 1752 a B e
Pull down on the Datasheet menu item and click Freeze columns.
EIA-176 Query System 12/2/05 - 19 of 39
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Es EIA-176 Query Syztem

“ File Edit | Datashest Tools Exit

“g - E!’L Fonk, ..
Bl Freeze Columns
%l Sork Ascending
| El Sork Descending
W advanced FilkerjSart. .
M ¥ _ apply Filker/Sart
"B Remove Filker Sort

&' Qry_AllCon_1 : Select Query

The COMPANYNAME column always

appears at the left. Even when scrolling to the
right, COMPANYNAME stays on the screen:

COMPANYNAME ComCost |ComConsumer| Othe
BARROWY UTIL & ELEC COOP [MC 756 030 215
UKPEAGVIK ARCTIC SLOPE 507 003 3
ALASKAP L CO 0 0
EMNSTAR MNAT GAS CO 21445 075 12,420
MARATHON QIL CO 0 0
CHEVRON USA PROD INC 0 0
UMNIOMN OIL CO OF CALIFORMIA, 0 0
PHILLIPS ALASKA NAT GAS CO 0 0
ARCO ALASKA INC 9,296 911 25
FLORALA GAS DEPT 1,305 4
WEST JEFFERSON GAS 5YS 25 266 22
ALABAMA GAS CORP T8 594 955 33822
| |MIDCOAST INTERSTATE TRANS I 0 0

Record: 1] 1] 1 v |mfofof 1792 [ i - |

EIA-176 Query System

Columns can be ‘unfrozen’ only by exiting the query grid.
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Datasheet Tools Exit
A Eont...
i [0 Freeze Columns

124

| o | & @ 8} %

Sort Ascending

%1 sort Descending -‘

T Advanced FilterfSort. ., COMPANYNAME ﬁ

¥_ apply Fitter/Sort ROW UTIL & ELEC COOP INC AK 2191 ;

W, Rernove FilterSort EAGYIK ARCTIC SLOPE A

| [ 1/8020168K  |ALASKAF L CO Al

| [176020174K  ENSTAR NAT GAS CO Al 585

| [176133004K  MARATHOM OIL CO Al

| [176175444K CHEVRON USA PROD INC

| [176175454K  UNION OIL CO OF CALIFORMIA,

| [ 17819883AK | PHILLIPS ALASKA NAT GAS CO

| [ 17B22751AK | ARCO ALASKA INC

| |17600048AL  |FLORALA GAS DEFT

| |17600049AL WEST JEFFERSON GAS 5Y5 p

| |17800139AL | ALABAMA GAS CORF 258,
178001414L  MIDCOAST INTERSTATE AN T AL

Recﬁ?&lﬂmr‘_‘d—r 3 |>| |>*| of 1792 ;

To use the sort ascendmg feature select a column by clicking on the column heading. Pull down the Datasheet
menu and click on Sort Ascending. The query will be sorted according to the values in the selected column.

i Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol
P 7680806TX.  |PANENERGY TEXAS INTRASTATE | TX ﬂ
17684747M0D ALLIANCE PIPELIME MO 0
17692405FL  SOUTHERMN NAT GAS CO FL 0
1769232711 SOUTHWEST GAS STORAGE CO 1L 0
17692326MI SOUTHWEST GAS STORAGE CO M| 0
176906030 KN INTERSTATE GAS TRAMSLLC MO 0
17690514CA  CPM PIPELINE COMPAMNY CA, 0
176905060 DESTIN FIPELIME O LLC MS 0
17692726MM  PINMNACLE NATURAL GAS CO M1 0
17681218AR OZARK GAS TRAMS LLC AR 0
1769272401 SEMCO EMNERGY PIPELIMNE b | 0
176806197 LOWWER COLORADO RIVER AUTHC TX 0
17680617LA JEFFERSOMN ISLAND STRGE & HU Lx‘—\ 0
Record 1l <111 »imbslof 1792 4l I .

In the example above the ResVol values are sorted in ascending order, starting with zero.

Sort descending works the same way.
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g=f Qry_AllCon_1 : Select Query

CompanylD COMPANYMNAME ST ResVol

’_ 17621931CA | SOUTHERM CALIFORNIA GAS CO CA 251,452 001
L |178103221L MICOR GAS IL 221,009, 522
L 17810817 CA PACIFIC GAS & ELEC CO CA 211,181,852
L |17B1T183MI CONSUMERS ENERGY CO il 176,663,600
L |17608432M MICHIGAN COMSOL GAS CO il 136,124,328
L |17611456NJ  PUB SVC ELEC & GAS CO MJ 132,611,115
__|176T02170H  EAST OHIO GAS CO OH 131,187,521
__ | 1761096011 PECPLES GAS LT & COKE CO 103,856 141
| 17601565NY  KEYSPAMN ENERGY DEL CO 89 463 564
__|17611459C0  PUB SVYC CO OF COLORADO 86,738,306
| 176162350H  COLUMEIA GAS DIST CO 78,312,118
| 17617436TX THU GAS DISTRIBUTION 75,700,391

L | 17622739MN RELIANT ENERG‘T’ MINNEG CO MN 68 957,947

With sort descending the largest values appear first.
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_Qatasheet Tooks Exit
| A Eont.. e etz v RY A x| Ba- 0

§ [ Freeze Columis
" &1 sort Ascending

2} Sort Descending

Bl chvancec Fiterjort... COMPANYNAME ResVol ResCost |ResConsumery§ CommVol
T Apply Fitter/Sort ROV LTIL & ELEC COOP INC AK 221,971 5145100 1132 387,816
K Remove Fiter/Sort EAGVIK ARCTIC SLOPE AR 0 0o 0 1465764
| [17802016AK  ALASKAPL CO AR 0 0o 0 0
| [17802017AK ENSTAR NAT GAS CO AR 15,756,588 56,585,987 .0 0,117 5,698,403
| |17613300AK  MARATHON OIL CO AR 0 0o 0 0
| [176175444K  CHEWVRON USA PROD INC AR 0 0o 0 0
| [178175454K  UMION OIL CO OF CALIFORMIA  AK 0 0o 0 0
| |17619863AK  PHILLIPS ALASKA NAT GAS CO - AK 0 0o 0 0
| |17622751AK  ARCO ALASKA INC AR 0 0o 0 7,099,290
| |17600048AL  FLORALA GAS DEPT AL 21,680 133,170.0 542 212
| [178000494L  WEST JEFFERSON GAS 5Y5 AL 25,653 2489930 520 3,779
| |17600139AL  ALABAMA GAS CORP AL 27,627,365 258,718,088.0 430,069 9,747,205
| 1760014140 MIDCOAST INTERSTATE TRANS INAL 0 0o 0 0
S O N T TR T | s = =

To use the Advanced filter option no rows need to be selected. Just pull down the Datasheet menu and click on
the Advanced filter option.

The filter design window will appear.

g=f Qry_AllCon_1Filter1 : Filter This window can be resized by
. stretching the edges.
Qry_AlCon_1

+

1) The first step is to copy the field
you want to search from the field
list into the criteria grid.

CompanyID
COMPAMNYMAR
aT <

Rl j

an either drag the name of
the column you want to search or
sort by in the upper pane of the

<] |

' — window into the criteria grid in the
Field: (] - lower pane of the window, or
ok double click on a field to copy it to
Criteria: the next available field cell in the
ek grid.

|
8 Qry_AllCon_1 : Select Query

__| CompanylD COMPANYNAME ST ResVol HR| CommVyol |C|Cor OtherNugsyol
’_ 7 al CALERA CITY OF AL o7.665 12 20917 210 1,688
_|17e1es7eAsl SOUTHWEST GAS CORP AL 26,146,540 14 20,419,530 3 29 3,832,109
_|17608584CA  LONG BEACH CITY OF CA 5,183,814 16 2,103,884 4 11 313,244
_|17810617CA PACIFIC GAS & ELEC CO CA L 211,181,852 18 58,646,965 3 148 660,992
_|17810644CA PALO ALTO CITY OF CA, 1,366,627 13 1,363,762 7 156 24 841
_|17802792CT  YANKEE GAS SYC CO CT 13,288,447 10 7,237 B66 |3 150 241,615
_[17B12046FL  INDIANTOWN GAS CO FL 17,799 01 11,2181 129 683,174
_|17813094GA HOGANSVILLE CITY OF GA, 69,909 13 14157 13 15 2,018
_|17B081641A, LAMONI MUN UTIL IA, 62,140 10 26421 7 08 1,961
1761904814, ROLFE MUN GAS SYS |A, 30,306 149 9,553 3 41 4,442
_|17606308IL ILLINOIS PWR CO IL 33642111 18 14,213,085 5 28 1,964,110
_[17621016KY  RICHARDSVILLE GAS CO KY 3567518 60493 7 2,555

17616558MA | BAY STATE GAS CO Ml 23,083,858 14 5,339,596 7 104 137,634

Record: e[ ([ 7 D Inlie] of 37 (Filtered) 4] - |

[l

i T T
Eiald [mikm ol (= [ el | | |
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gzt Qry_AllCon_1Filter1 : Filter
Qry_AllCon_1

+

CompanyID
COMPAMNYMAP
aT

Rial L|

< |

2) By clicking on the Field column in the lower pane
you can get a list of fields in the query.

Field: -
Sort: |[ Dy AlCon_1.* -y
Criteria: || ComparylD r
or. || COMPANTYHAME —
ST
Ral
RCost
RConzumers
Cvol
|
3) In this example
Figld: | B%al we've selected the
Sork: S RVol field.

Titeria; || Azcending
o || Descending

4 |

You can pull down
the sort cell and

ot zarted) \ specify a sort order

if you want.

Field: [Pwal

Sark:

Criteria; | >900000
ar;

4) In the Criteria cell
we've entered a
condition that Rvol
be greater than
900000.

Datashest Tools Exit
A Fort..,
| [H1' Friesze Galimns
: %l SErt BscEndiNT
i El Sork escending
W Advanced Filker [Sort, .
S8 Anply Filker/Sort
B, Remove FilkerSort

5) Click on the
Apply/Filter Sort
toolbar button when

that don’t meet the

will disappear from
the view. They have
been filtered out. If
you click on the
Remove Filter/Sort
button they will
appear again.

you're ready to apply
the filter. Any records

criteria you specified

EIA-176 Query System
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COMPANYNAME | ST | ResVol
THNAT GAS CO Al 17 418,735
A4 GAS CORP AL 26 272 B3
fLLE NAT GAS DEPT AL 1,791 406
AST ALABAMA GAS DIST AL 1,72902
[ GAS SWC CORP AL 4 042 543
IATED MAT GAS CO AR 1,232,041
SASWESTERN GAS CO AR BE10,113
SAS DKLAHOMA GAS COF AR 25970524
T ENERGY ARKLA AR 25,166 915
ATY OF AL 1,024 295
NEST GAS CORP i 24 913 465
= UTIL ARIZOMA GAS DI Y AL 5 527 BaB
IEACH CITY OF CA, B 583,055
D 5AS & ELEC CO CA 234185 445

6) The rows that appear should meet the criteria. A note: on full survey datasets it helps to have plenty of
memory available. If you run a filter and nothing changes you may not have enough memory to process.

If you have enough memory, you are not limited to one field or value. You can select several fields in the
criteria grid. The EIA-176 Query system offers standard operators

= Equals

> Greater than

< Less than

>= Greater than or equal to
<= Less than or equal to
<> Not

To specify AND/OR criteria place the operators in different rows of the criteria grid.

To express AND criteria within a single field use the
AND operator

Field: [ST
Sort;
Criteria: | T and bl
ar;

This filter asks for a State value of TX AND MI.

" To express AND criteria between fields put each
Field: [ST Rital o Lo
St criteria on the same row of the criteria grid.
Criteria; |"T=" ]
ar: This statement asks for ST equal to TX and Rvol >
90000.
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- To express OR criteria within a single field use the
Field: [5T
S ot OR operator.
ork:
Criteria: | "Te< " Or "MI" .
- This statement asks for ST equal to TX OR Ml
To express OR criteria between multiple fields place
Field: [5T Fval the criteria on separate rows of the criteria grid.
Sork;
Criteria [T " This statement asks for ST equal to TX or Rvol >
o I>E|EIEIEIEI 90000.
|

EIA-176 Query System
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3.3.2 - Custom Queries
The Custom Queries option allows you to choose individual data items from the entire EIA-176 for inclusion in

datasets. The methods are similar to those used in the Pre-selected queries.

B EIA-176 Query Menu

Query Menu
Preselected
queries
create files
with
predetermined

EIA-176 items Pre-selected Queri

Custom .
queries create Custom Queries

files with EIA- Select your own data options, |
176 items that
are selected
from a list

Back

3.3.2.1 View EIA-176 Company Menu

First you will be prompted to select Companies and Year. This screen is similar to the Company selection
screen in other parts of the query.
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You can
select one
or more
companies
by name or
state .

Use the
arrow
buttons to
select a
state or
company.

Query EIA-176 Data - Choose EIA-176 Company(s)

Choose a retrieval method

Please enter a report year:

“  selecta Company in a State

%  Select a Company by Name

Select all Companies

Choose EIA-176 Companies to include in your query

After you've selected companies and the year, you will go onto the Select Reported Data Items button. You'll
be presented with a list of EIA-176 form data lines to pick from
3.3.2.2 Pick Reported Lines

B3 Custom Queries - Select Reported Data Items

User-Selected Queries - for year(s):
Select Reported Data Items

2004

‘You have
selected all
companies

GA o

Select data items

Yartf LineNof Description

Emmmmmmmmbbbbbbbbbb
=
o
)
_

120 Synthetic natural gas produc
0210 Underground Storage Withdre
0220 | Received from LNG

0230 Other Storage Withdrawals
0300 Transported into rpt ST fram
0400 | Receipts at City Gate

0500 Other Receipts

0600 Supplemental Gasous Fuels
0700 Total Supply

Inventory of LNG

0900 | Heat Content of consumer del
1010 Del to Residential Sales

1020 Del to Commercial Sales
1030 Del to Industrial sales

1040  Del to Electric Power Sales
1050 Del fo Wehicle Fuel

1060 Del to Cther (see footnotes f_D;_.|

01110 Gas Produced onsystern by cj

i

Matural Gas Survey Forms

Refer to the survey form for information about items.

Once all your selections have been made click Finished Selecting./

Finished
Selecting

<=Back

Each line
item with
data from
the form is
represented
with a short
description.
The Part
and Line
Number is
also
included.
The
highlight
method is
similar to
that in the
Company
screen.

The items are labeled like the lines on the survey form. If you select the ‘Natural Gas Survey Forms’ hyperlink
you'll be taken the Natural Gas survey form page, and can view a copy of the EIA-176 survey form and

EIA-176 Query System
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instructions. If you have questions about which items you want to see this can be useful.

Natural Gas

Home > Matural Gas > Matural Gas Survey Forms

TIRSTGOV

What's New

Publications

Proposed Natural Gas Survevs

Applications

Survey Forms EIA’s Natural Gas Division Smrvey Formn Comments

ﬁpgd“a:::‘“' (Eeel The public comment period for the natural gas forms clearance package,
secking a 3-year extension for data collection activities, conchaded

(e tEE (S Friday, May 6. ELA will review all comments before making a final

Energy A-Z proposal to OME later this summer. Please contact: Steve Nalley at 202-

Privacy / Security 286-0059 or snallewiileia. doe. zov should you have questions.

Featured

Publications Current Slll'Vey FOl‘mS

Recent Monthly
Statistics

T;_r‘-;al coti i Natural Gas Sury Tins Reserves Survey Forms

Projections to 2025

'al Gas Swrvey Forms Instructiony

-176, " Annual Report of Natural and Supplemenial Gas Supply and PDE
Disposition™
& detailed State lewel balance of supply and disposition is reported by all
companies which phsically take possession of natural gas (e.g.
synthetic gas producers, processors, distributors, storage operstors, and
ipeline operators) excluding producers and consumers. A PCohased
ication fior filing this form is dlso available. Frequently asked
bout the form are answered in FAQ: Form 176

3.3.2.3 Select Quantities and Build Calculated Items

The Select Quantities and build Calculated Items screen has three parts.
Aggregate functions

Select Company Available Quantities.

Calculated field.
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B User Selected Queries - Select Quantities and build Calculated Items ) [
Make your type of operations and quantity selections before Add a Calculated
==Back clicking Complete. Field > Complete=>
Aggregate functions Average ﬂ
agreg Count
Sum -
4 I I L3
Select a Type of Investor Owned distributor ﬂ
Operations hunicipally owned distributar
{default is All) Privately ovwned distributor
Co-op distributor ;l
Un-check available quantities to include or exclude quantites  Available Quantities Quantities to include =
in you custom query in Query Output
Line Hum of Hum
Part Humber Description VYol Cost Consum Btu Mcf  wol Costor Btu Mcf
[T [o700][Total Supply FO [ [ & rC
[6 " [1010] [Del to Residential Sales | R L I I G2 —-—
Ili_|1l12ll [pel to Commercial Sales IY_ I‘f_ I‘."_ I_ I_ | 2 r r
|6 [1030] [Del to Industrial sales | 2 2 IO I 2 C T2 W W
[6 " [1040][Del to Electric Power Sales | 2 R I I T e W
- EE N mE s ]
1 o

Available Quantiges:/

For<€ach line item you select this portion of the screen will have a row.
The Available Quantities portion shows you what quantities are available for this item.
The Quantities to include portion allows you to include or exclude quantities.

For this example, if you aren’t interested in the Number of Consumers for deliveries to

Residential Sales, you would use the mouse to deselect that item, and it won’t appear in your
query data file.
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Type Of Operations

You can select multiple Types of Operations if you choose.

If no selection is made, all types are included. If they are all included they are not identified.

Aggregate functions

Aggregate functions

Average
Court

Sum
1

.

o

The Aggregate functions provide summary statistics for all the companies selected. The
Aggregate functions, the Type of Operations, and the Add calculated functions are mutually

exclusive.

5] User Selected Queries - Select Quantities and build Calculated Items

<=Back |

Make your type of operations and quantity selections before
clicking Complete.

=10

Add a Calculated

Field =» it

Aggregate functions

Average =
Count

Sum -
<I I 13

Select a Type of
Operations
(default is All)

Investar Cuevned distributar ﬂ
Municipally owned distributor
Privately owned distributor

Co-op distributar ;l

In the following example the Aggregate function has been grouped by Delivered to Consumers

g=f Dynamic_Query : Select Query

ST Year SmDIResSalvl| SmDIResSalCs| SmDIResSalN(
| X 2000 17633964 F4256459 Aa924
| |AL 2000 42426740 355824275 770220
L |AR 2000 IR244801 281571912 254121
| |AL 2000 32940263 300731424 B024E9
| [CA 2000 AE4A74838 3737897351 9315830
| |[cO 2000 111748319 GBO16E33106 1265032
| |CT 2000 3834174 404416526 442457
(DG 2000 13182680 114736868 126714
| |DE 2000 aaEz099 7E480714 115961
| |FL 2000 136585251 168R53955 SEREZT
| GA 2000 58425502 269730510 BE7480
| [HI 2000 f23675 99335354 20708
(1A 2000 71408355 435303533 793790

recards 4] 4 [T 1 v |wi]r#] of 51 1]
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When you
select
Aggregate
functions
other
options
become
disabled.

The
results of
the query
with sum
aggregate
function.
Notice
that the
column
headers
all start
with Sm —
for Sum.
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“ File Edit Datashest Tool:

Save As/Export,.,
ol Page Setup...
& Prink Preyiew

Close
Datasheet Yiew
&5 Frint...

Exit

The File menu provides your query output options.
Close — closes the query and returns you to the
selection screen.

When you return to the selection screen your
company, year and data item selections will still be
in place. Any aggregate functions will be cleared.

& User Selected Queries - Select Quantities and build Calculated Items o ] S
Make your type of operations and quantity selections before Add a Calculated
==Back clicking Complete. A Field => Complete=>

v A

Average o
Courit

3um -
<I I *

Aggregate functions

Select a Type of
Operations
(default is All)

Inwestor Owwned distributor ﬂ
Municipaly owned distributor
Privately ovened distributor

v A

Co-ap distributor ;l
Un-check available quantities to include or exclude quantites
inyou custom query
Line
Part Humber Description
[ [0700 [Total Supply /
[6 " [1010 [Del to Residential Sales /
IB_I1I]2II |I]e| to Commercial Sales /
|6 [1030 [Del to Industrial sales /
|6 [1040' [Del to Electric Power Sales /
<| /

Quantities to include =
in Query Output

ailahle Quantities

am B WEIeE s
a3 o WE Yy om
a3 o WE Yy om
a3 o Wm Yo Eose
a3 o WE Y s s
EE m mEss = s

o

To Add a Calculated Field make yoAuantity selections first, and don’t select an Aggregate function. Then
click on the Add a Calculated Field button. This opens another window.

EIA-176 Query System 12/2/05 -
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i Uszer Specified Calculations Choose variables from this list.

ElIA-1T6 Query System - User D

Available EIAATE variables [[DIResSalvol] -] ¢l
[DIResSalCst] & Your expre

appear here.

|DIResSalCon)
Click on wariables to add to [DIComSalol]
the expression [CIComSaiCst]
[DIComSaCaon)

Cloar ExpressionBox | |NilindSatvinll =

Lise the avallable variables and the operators to build your expr

(':heck your #"tﬂl 4 

Available EIA-176 variables | When you click on a variable in the _
[DIResSalCst] Qvallable box, then it will appear in the expression
[DIResSalCon] ox.
Click on variables to add to [DICom=zalvol]
[DIComZalCon] your calculation.
Clear Expression Box [MnASaknl Click on operators to add + | <=add
Use the available variables and the operators t calculations ==> | <=subtract
(check your syntax) |
[DIResSalvol] * | <Muitiply
{ | <=Divide
T | <=left
prassion { parenthesis
] <=right
parentheisi
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Use the availabhle variables and the operators to build your expression : {p_areh":he Once
(check your syntax) ﬂ parrlgn‘thEi y°‘.”"e
[DIResSalvol] + [DICemSalval] built your
Complete Expression expression,
click on
Camplete your expression Complete
Expression
to finish.
Use the available variahles and the operators to build your expression "im_c"' You must name your
{check your syntax) ﬂ ;;:EHT expression in
. [DIResSalval] + [DIComSalval] AS the Enter a Column
Complete Expression Name box.

Add Another
Expression=>

TOTAL
Enter a Column Name
Finighed == Run Query

If you want to add another expression click add Another Expression=>.

The expression box will be cleared out and you can start another expression. Your first expression will be
held for the query.

When you are finished, click Finished=> Run Query. This will immediately run the query.

Note: you can click and edit the expression in the expression box.

g=8 Dynamic_Query - Select Query

ST COMPANYNAME Year | DIResSalVol |DI|D| DIComSalol | DIC| D) DI D| DIl TOTAL

M| ks ABBYWILLE CITY OF 2000 4427 0411 824 H311213 2 5241
1A MOULTON MUN GAS S¥5 2000 19253 05 12 900 +#4 1 00 0 25143
IA | BEDFORD CITY MNAT GAS 2000 520140512 20794052 00/ 0 79093
IL | TOLEDO YILLAGE OF 2000 F026 05 12 12428 #0041 13)4 3 459454
IL | SIMS VILLAGE OF 2000 10257 04 12 330 #3300 0 105587

The columns have been resized and hidden (by clicking in the column headers) to show the TOTAL variable.
It is the sum of DLResSalVol And DIComSalVol.

Query : Select Query

COMPANYNAME Year DIResSalvol (DI DI DIComSalVal | DIC| D) DI D DI
IBYWILLE CITY OF 2000 4427 04N 824 {131 1213 2
CULTOM MUN GAS S5 2000 1926305 12 g0 #1411 00 0
EDFDRD ClT".I." NAT GAS ninint Cand 4 0 1T ATOTO O T AN
ILEDO YILLAGE OF ElA-176 Query System E3
M= YILLAGE OF

Do you want to zave changes to the layout of querny 'Diynamic_Huen"?

RAND TOWYER CITY OF
HAVNEETOWWN MUN GAS
TTEBURG GAS CO

3ITA SPRINGS NAT GAS &1
=W BOSTON MUN GAS 5Y3 2000 26343 05 12 4875/ H#14/1 00 0O

Mo Cancel

Because the columns were edited in the datasheet, this prompt appears after choosing the Close option
from the File Menu. Dynamic_Query is where user selected-queries are temporarily stored. It does
not matter if they are saved or not.
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After you close the query you're returned to the Select Quantities and build Calculated Items
Menu.

B User Selected Queries - Select Quantities and build Calculated Items -0l =]
Make your type of operations and quantity selections before Add a Calculated
==Back clicking Complete. Field = Complete=>
Aggregate functions il ﬂ
garey Count
Sum -
4 I I L]

Select a Type of
Operations
{default is All)

Irevestor Crwened distributor ﬂ
Municipally owvened distributor
Privately owned distributor

Co-op distributor ;l
Un-check available quantities to include or exclude quantites  Available Quantities Quantities to include 2]
in you custom query in Query Output

Line Hum of Hum
Part Humber Description Vol Cost Consum Btu Mef  yol Costof Btu Mcf
[ [o700][Total Suppiy am m EE 38 =5 ==
|6 [1010] [Del to Residential Sales | A T I LS T TR W
Iﬁ_lﬁlﬂeltu Commercial Sales |‘|'_ |‘|"_ I".'_ I_ I_ | . ]
Iﬁ_lﬁlneltn Industrial sales I‘f_ I‘."_ IY_ I_ I_ {2 I ™ I L
IB_ IW |De| to Electric Power Sales |‘|'_ |‘|"_ Iv_ I_ I_ | 2 ]
- il i

To run the query you just constructed again you can click Run Query.

EXit returns you to the main queries menu.

EIA-176 Query System 12/2/05 -
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Appendix A — EIA-176 Survey Form
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Appendix B — Pre-Selected Query Items

Querydescription

QueryMemo

All Sector items sorted by state
Name and Address Information
Detail level Continuation Lines
Footnotes and Associated Data
Sector Vols sorted by sector
Sector Vols ranked nationally

Sector Vols sorted by company type

LNG & Underground Gas Storage
Sector Vols ranked by state
Sector Prices sorted by sector
Sector Vols for Investor Owned
Sector Vols for Municipally Owned
Sector Vols for Privately Owned
Sector Vols for Cooperatively
Sector Vols for Other Distribution
Sector Vols for Interstate Pipelines
Sector Vols for Intrastate Pipelines
Sector Vols for Storage Operators
Sector Vols for Synthetic Natural
Sector Vols for Producers

Sector Vols for Gathers

Sector Vols for Liquefied Natural
Sector Vols for Other Operators

EIA-176 Query System

This query includes company data sorted by state for lines 10.1 thru

This query includes the Company Name, State of Operation ,Type of
This query shows continuation lines with the company reference for Parts
This query shows data values and associated footnotes for selected

This query includes company data sorted by sector -Residential,

This query includes company data sorted by volume amounts.

This query includes company data

This Query has LNG and Underground Storage Injections & Withdrawals,
This query includes Company data sorted and ranked by volume amount
This query includes prices for consumption data - lines 10.1 thru 10.4,
This query includes only companies who checked A on Section Il. Type
This query includes only companies who checked B on Section Il. Type
This query includes only companies who checked C on Section II. Type
This query includes only companies who checked D on Section II. Type
This query includes only companies who checked E on Section Il. Type
This query includes only companies who checked F on Section II. Type
This query includes only companies who checked G on Section Il. Type
This query includes only companies who checked H on Section II. Type
This query includes only companies who checked | on Section Il. Type of
This query includes only companies who checked J on Section Il. Type
This query includes only companies who checked K on Section Il. Type
This query includes only companies who checked L on Section II. Type
This query includes only companies who checked M on Section Il. Type
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Appendix C — User Selected Query Item names

UserQueryName

| uQpPart |uUQLin|

Gas Produced onsystem by company
Synthetic natural gas produced
Underground Storage Withdrawals
Received from LNG

Other Storage Withdrawals
Transported into rpt ST from: ST or Cntry
Receipts at City Gate

Other Receipts

Supplemental Gasous Fuels

Total Supply

Inventory of LNG

Heat Content of consumer deliveries
Del to Residential Sales

Del to Commercial Sales

Del to Industrial sales

Del to Electric Utility Sales

Del fo Vehicle Fuel

Del to Other (see footnotes for type)
Trans to Residential Consumers
Trans to Commercial Consumers
Trans to Industrial Consumers

Trans to Electric Utilities

Trans for Vehicle Fuel use

Trans to Other (see footnotes for type)
Pipeline Compressor Use

New Pipeline Fill

Distribution Company Use

Other (see footnotes for type)
Underground Storage Injections
Liquefied natural gas (LNG) Injections

Other Storage Injections (see footnotes for type)

Trans to State Line: Comp ST/Cntry
Lease Use
Returned to oil and/or gas reservoirs

Losses from leaks, migration, damage and/or

Other Disp: Distribution Companies
Other Disp: Other Pipelines

Other Disp: Storage Operators
Other Disp: Other (Specify type)
Total Disposition

Unacc't for gas supply

EIA-176 Query System

OO O OO O OO OO OO OO O O OO O OO OO OO UMMM DMIEAEMAMMMMALAS

12/2/05 -

0110
0120
0210
0220
0230
0300
0400
0500
0600
0700
0800
0900
1010
1020
1030
1040
1050
1060
1110
1120
1130
1140
1150
1160
1210
1220
1230
1240
1310
1320
1330
1400
1500
1600
1700
1810
1820
1830
1840
1900
2000
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